The information in this manual is subject to change without notice and should not be construed as a commitment by ABB. ABB assumes no responsibility for any errors that may appear in this manual.

Except as may be expressly stated anywhere in this manual, nothing herein shall be construed as any kind of guarantee or warranty by ABB for losses, damages to persons or property, fitness for a specific purpose or the like.

In no event shall ABB be liable for incidental or consequential damages arising from use of this manual and products described herein.

This manual and parts thereof must not be reproduced or copied without ABB's written permission.

Additional copies of this manual may be obtained from ABB.

The original language for this publication is English. Any other languages that are supplied have been translated from English.
### Table of Contents

**Overview**  
5

**1 Release Information**  
6

- **1.1 General**  
   6
- **1.2 Prerequisites**  
   7
- **1.3 System requirements**  
   7
- **1.4 Simulation Models**  
   9

**2 What's new in RobotStudio 5.61**  
12

- **2.1 Other changes**  
   13

**3 Late Breaking Information**  
14

**4 Corrections**  
15

- **4.1 Corrections in RobotStudio 5.61**  
   15
- **4.2 Other limitation solved**  
   16

**5 Known Limitations**  
18

- **5.1 General**  
   18
- **5.2 Online**  
   18
   - **5.2.1 Online - Paint**  
     18
   - **5.2.2 Online – Integrated Vision**  
     19
- **5.3 Offline**  
   20
   - **5.3.1 General**  
     20
   - **5.3.2 Station Viewer**  
     22
   - **5.3.3 Signal Analyzer**  
     22
   - **5.3.4 MultiMove**  
     22
   - **5.3.5 Virtual FlexPendant**  
     23
   - **5.3.6 External Axis**  
     23
   - **5.3.7 Network Drives and UNC Paths**  
     23
   - **5.3.8 RAPID**  
     24
   - **5.3.9 Building Controller systems**  
     25
   - **5.3.10 Paint**  
     26
   - **5.3.11 Conveyor Tracking**  
     26
   - **5.3.12 Graphics and Geometry**  
     27
   - **5.3.13 Gearbox Heat Prediction Tool**  
     28
- **5.4 ScreenMaker Limitations**  
   28
# Table of Contents

6 RobotWare Compatibility 30

6.1 General 30
6.2 RobotWare 5.05 and 5.06 Compatibility 30
6.3 RobotWare 5.07 Compatibility 30
6.4 RobotWare 5.08 Compatibility 30
6.5 RobotWare 5.10 Compatibility 30
6.6 RobotWare 5.11 Compatibility 31
6.7 RobotWare 5.12 Compatibility 31
6.8 RobotWare 5.13 Compatibility 31
6.9 RobotWare 5.15 Compatibility 32
6.10 General Compatibility Limitations 32
6.11 ScreenMaker Compatibility 32
6.12 Support for future RobotWare versions 33

7 Installation information 34

7.1 Installing RobotStudio 34

8 Technical support 37

8.1 Overview 37
Overview

Description

This document provides information about the new features, problems corrected, and installation of RobotStudio.

Product Overview

RobotStudio lets you install, configure, and program ABB robots. You can do this both offline, using virtual robots, and online, connected to real robots.

RobotStudio is categorized into the following two feature levels:

- **Basic** - Offers selected RobotStudio functionality to configure, program, and run a virtual controller. It also includes online features for programming, configuring, and monitoring a real controller connected over Ethernet.

- **Premium** - Offers full RobotStudio functionality for offline programming and simulation of multiple robots. The Premium level includes the features of the Basic level and requires activation.

RobotStudio offers the following installation options:

- **Minimal** - Installs only the features required to program, configure, and monitor a real controller connected over Ethernet.

- **Complete** - Installs all the features required to run the complete RobotStudio. If installed with this option, additional features of Basic and Premium functionality are available.

- **Custom** - Installs user-customized features. This option allows excluding unwanted robot libraries and CAD converters.

**Note**

**RobotStudio 64-bit edition** is installed for the *Complete* installation option on computers with a 64-bit operating system. The 64-bit edition allows large CAD-models to be imported as more memory can be addressed. However, the 64-bit edition has the following limitations:

- Integrated Vision is not supported
- SafeMove Configurator is not supported
- EPS Wizard is not supported
- ScreenMaker is not supported
- Add-ins will be loaded from the following folder
  
  C:\Program Files (x86)\ABB Industrial IT\Robotics IT\RobotStudio 5.60\Bin64\Addins
1 Release Information

1.1 General

Release Name

The release name is RobotStudio 5.61 and the build number is 5.61.5913.104.

Release Date

The release date is April 14th, 2014.

CAD Converter Options

The CAD Converter options can be set by using the Advanced button of the Settings dialog of the CAD Converter. By pressing the Advanced button, the CADConverter.ini file is opened. The file specifies all available options for CAD conversion. To change an option, simply uncomment the line by removing the semicolon and modify the option as desired. All options are described in the file ‘AcisInterOpConnectOptions.pdf’ in the RobotStudio folder of the RobotWare DVD.

Demo stations

There are three demo stations included in this version.

- Demo AW Station
- Demo Solar Simulation
- Demo TwoRobotsAndConveyor.rspag (requires RobotWare 5.15)

They are stored in the Pack & Go format (.rspag) and can be opened with the command Unpack & Work on the Share section of the RobotStudio menu.

1 A download for RobotWare 5.15.0x (the latest available revision of RobotWare 5.15) will be presented in the Unpack&Work wizard if no compatible RobotWare version is installed.

ScreenMaker Demo Station and Project

There is a demo station and associated ScreenMaker project available.

- SCM_ExampleProject (ScreenMaker Project)
- SCM_ExampleStation (RobotStudio station)

These files are found in the ‘Addins/ScreenMaker/Samples’ folder under the RobotStudio installation folder.

Tutorials

Tutorials are available at the RobotStudio product pages at http://www.abb.com/roboticssoftware

Language Support

RobotStudio is available in the following seven languages: English, French, German, Spanish, Italian, Japanese, and Chinese (simplified).

ScreenMaker supports only English when building the application in RobotStudio. ScreenMaker Designer does not provide a localization tool. Therefore, applications created with ScreenMaker will display the same text specified at design time, regardless of the choice of language on the FlexPendant.
If Asian languages are used (Chinese, Japanese, Korean) then these screens will display correctly only when the FlexPendant language matches the ScreenMaker language. Otherwise empty markers will appear where the text characters should be.

### Documentation

User documentation for RobotStudio is available from the Help button (QRST) in the upper-right corner of RobotStudio.

The complete documentation in PDF for RobotWare including RobotStudio is available on DVD and can be ordered separately from ABB.

### 1.2 Prerequisites

**Before you install…**

Before you begin installing RobotStudio, you must have Administrator privileges to successfully complete the installation.

The Microsoft component .NET Framework 3.5 is required for ScreenMaker. For computers connected to the Internet the component is automatically downloaded and installed if needed.

If you are using Windows 8.1 and there is no Internet connection during the installation, you need to install the .NET Framework 3.5 manually according to the following Microsoft instruction, [http://msdn.microsoft.com/en-us/library/hh506443](http://msdn.microsoft.com/en-us/library/hh506443).

### Licensing

RobotStudio is categorized into the following two feature levels:

- **Basic** - Offers selected RobotStudio functionality to configure, program, and run a virtual controller. It also includes online features for programming, configuring, and monitoring a real controller connected over Ethernet.

- **Premium** - Offers full RobotStudio functionality for offline programming and simulation of multiple robots. The Premium level includes the features of the Basic level and requires activation.

### RobotStudio 64 bit

**RobotStudio 64-bit edition** is installed for the Complete installation option on computers that have a 64-bit operating system. The 64-bit edition allows large CAD-models to be imported as it can address more memory than the 32-bit version. However, the 64-bit edition has the following limitations:

- Integrated Vision is not supported
- SafeMove Configurator is not supported
- EPS Wizard is not supported
- ScreenMaker is not supported
- Add-ins will be loaded from the following folder

  C:\Program Files (x86)\ABB Industrial IT\Robotics IT\RobotStudio 5.61\Bin64\Addins

### 1.3 System requirements

**Software requirements**

<table>
<thead>
<tr>
<th>Operating System</th>
<th>32-bit edition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Microsoft Windows 7 SP1</td>
<td></td>
</tr>
</tbody>
</table>
Microsoft Windows 7 SP1 (recommended)  64-bit edition  
Microsoft Windows 8.1 (recommended)  64-bit edition

**Note**

RobotStudio 5.61 does not support Windows XP and Vista. The reason is that RobotStudio uses .NET Framework 4.5 which is not supported by XP or Vista.

RobotStudio is not tested on Windows 8.1 32-bit edition, why it is not added to the list of supported operating systems. However, at the time of writing, there are no known obstacles that prevent RobotStudio to run on Windows 8.1 32-bit.

---

**Note**

The Windows Firewall will try to block features necessary to run RobotStudio. Make sure to unblock these features when asked (Industrial Robot Discovery Server, RobotStudio StudioAppFramework module, Virtual RobotController (all published by ABB)). The blocking state of a certain program can be viewed and changed at Start/Control Panel/Windows Security Center/Windows Firewall. Read more on [http://www.microsoft.com](http://www.microsoft.com).

---

### Hardware Requirements

<table>
<thead>
<tr>
<th><strong>CPU</strong></th>
<th><strong>2.0 GHz or faster processor, multiple cores recommended</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Memory</td>
<td>3 GB if running Windows 32 bit edition</td>
</tr>
<tr>
<td></td>
<td>8 GB if running Windows 64 bit edition</td>
</tr>
<tr>
<td>Free disk space</td>
<td>5+ GB free space</td>
</tr>
<tr>
<td>Graphics card</td>
<td>High-performance DirectX 11 compatible graphics card. For the Advanced lightning mode Direct3D feature level 10_1 or higher is required.</td>
</tr>
<tr>
<td>Screen resolution</td>
<td>1920 x 1080 pixels or higher is recommended</td>
</tr>
<tr>
<td>DPI</td>
<td>Normal size (100% / 96 dpi) up to Large size (150% / 144 dpi) Only Normal size supported for Integrated Vision.</td>
</tr>
<tr>
<td>Mouse</td>
<td>Three-button mouse</td>
</tr>
<tr>
<td>3D Mouse [optional]</td>
<td>Any 3D mouse from 3Dconnexion, see <a href="http://www.3dconnexion.com">http://www.3dconnexion.com</a>.</td>
</tr>
<tr>
<td>Disk Drive</td>
<td>DVD-ROM Drive (required only if you receive the RobotStudio installer on a DVD).</td>
</tr>
</tbody>
</table>
1.4 Simulation Models

Robot Libraries

<table>
<thead>
<tr>
<th>IRB Variant</th>
<th>IRB Variant</th>
<th>IRB Variant</th>
</tr>
</thead>
<tbody>
<tr>
<td>120 3kg/0.58m</td>
<td>360 3kg/1130 Wash-down No axis 4</td>
<td>6640 165kg/2.8m DP6</td>
</tr>
<tr>
<td>120T 3kg/0.58m</td>
<td>360 3kg/1130 Standard</td>
<td>6640 185kg/2.75m DP6</td>
</tr>
<tr>
<td>140 5kg/0.8m Type A/B</td>
<td>360 3kg/1130 Wash-down</td>
<td>6640 200kg/2.55m DP6</td>
</tr>
<tr>
<td>140 5kg/0.8m Type A</td>
<td>360 3kg/1130 Stainless</td>
<td>6650 120kg/3.2m</td>
</tr>
<tr>
<td>140 5kg/0.8m Type C</td>
<td>360 1kg/1600 Standard</td>
<td>6650 200kg/2.75m</td>
</tr>
<tr>
<td>140T 5kg/0.8m Type C</td>
<td>360 6kg/1600 Standard</td>
<td>6650ID 175kg/2.75m</td>
</tr>
<tr>
<td>1400 Type A/B</td>
<td>360 8kg/1130 Standard</td>
<td>6650S 125kg/3.5m</td>
</tr>
<tr>
<td>1400H Type A/B</td>
<td>4400 45kg</td>
<td>6650S 200kg/3.0m</td>
</tr>
<tr>
<td>1520ID</td>
<td>4400L 10kg</td>
<td>6650S 90kg/3.9m</td>
</tr>
<tr>
<td>1600 5kg/1.2m</td>
<td>4400L 30kg</td>
<td>6660 100kg/3.35m</td>
</tr>
<tr>
<td>1600 5kg/1.2m Type A</td>
<td>4400S 30kg</td>
<td>6660 130kg/3.1m</td>
</tr>
<tr>
<td>1600 5kg/1.45m</td>
<td>4450S 30kg</td>
<td>6660 205kg/1.9m</td>
</tr>
<tr>
<td>1600 5kg/1.45m Type A</td>
<td>4600 20kg/2.5m</td>
<td>6700 145 kg/3.2m MH</td>
</tr>
<tr>
<td>1600 6kg/1.2m</td>
<td>4600 20kg/2.5m Type C</td>
<td>6700 150 kg/3.2m MH3</td>
</tr>
<tr>
<td>1600 6kg/1.45m</td>
<td>4600 45kg/2.05m Type C</td>
<td>6700 155 kg/3.05m MH</td>
</tr>
<tr>
<td>1600 7kg/1.2m</td>
<td>4600 60kg/2.05m</td>
<td>6700 155 kg/3.05m SW</td>
</tr>
<tr>
<td>1600 7kg/1.2m Type A</td>
<td>460</td>
<td>6700 175 kg/3.05m MH3</td>
</tr>
<tr>
<td>1600 7kg/1.45m</td>
<td>4600 40kg/2.55m</td>
<td>6700 175 kg/3.05m SW</td>
</tr>
<tr>
<td>1600 8kg/1.2m</td>
<td>4600 60kg/2.55m Type C</td>
<td>6700 200 kg/2.8m MH</td>
</tr>
<tr>
<td>1600 8kg/1.45m</td>
<td>4600 40kg/2.55m</td>
<td>6700 200 kg/2.8m SW</td>
</tr>
<tr>
<td>1600 10kg/1.2m</td>
<td>6400R 200kg/2.5m</td>
<td>6700 205 kg/2.8m MH3</td>
</tr>
<tr>
<td>1600 10kg/1.45m</td>
<td>6400R 200kg/2.8m</td>
<td>6700 205 kg/2.8m</td>
</tr>
<tr>
<td>1600ID 4kg/1.5m</td>
<td>6400R 120kg/2.5m</td>
<td>6700 140 kg/2.85m MH</td>
</tr>
<tr>
<td>2400 10kg</td>
<td>6400R 150kg/2.8m</td>
<td>6700 140 kg/2.85m SW</td>
</tr>
<tr>
<td>2400L</td>
<td>6400R 100kg/3.0m</td>
<td>6700 155 kg/2.85m MH3</td>
</tr>
<tr>
<td>2600 12kg/1.65m</td>
<td>640</td>
<td>6700 155 kg/2.85m</td>
</tr>
<tr>
<td>2600 20kg/1.65m</td>
<td>660 180kg/3.15m</td>
<td>6700 220 kg/2.65m MH</td>
</tr>
<tr>
<td>2600 12kg/1.85m</td>
<td>660 250kg/3.15m</td>
<td>6700 220 kg/2.65m SW</td>
</tr>
<tr>
<td>2600ID 8kg/2.0m</td>
<td>660 175kg/2.80m</td>
<td>6700 235 kg/2.65m MH3</td>
</tr>
<tr>
<td>2600ID 15kg/1.85m</td>
<td>660 225kg/2.55m</td>
<td>6700 175 kg/2.65m MH</td>
</tr>
<tr>
<td>260</td>
<td>6600 185kg/2.55m</td>
<td>6700 200 kg/2.6m MH3</td>
</tr>
<tr>
<td>340</td>
<td>6620 150kg/2.2m</td>
<td>6700 200 kg/2.6m</td>
</tr>
<tr>
<td>360 1kg/1130 Std No axis 4</td>
<td>6620LX 150/1.9m</td>
<td>7600 150kg/3.5m</td>
</tr>
<tr>
<td>360 1kg/1130 Wash-down No axis 4</td>
<td>6640 130kg/3.2m</td>
<td>7600 325kg/3.1m</td>
</tr>
<tr>
<td>360 1kg/1130 Standard</td>
<td>6640 180kg/2.55m</td>
<td>7600 340kg/2.8m</td>
</tr>
<tr>
<td>360 1kg/1130 Stainless</td>
<td>6640 185kg/2.8m</td>
<td>7600 400kg/2.55m</td>
</tr>
<tr>
<td>360 1kg/800 Std No axis 4</td>
<td>6640 205kg/2.75m</td>
<td>7600 500kg/2.3m</td>
</tr>
<tr>
<td>360 1kg/800 Wash-down No axis 4</td>
<td>6640 235kg/2.55m</td>
<td>7600 500kg/2.55m</td>
</tr>
<tr>
<td>360 1kg/800 Std</td>
<td>6640ID 170kg/2.75m</td>
<td>780</td>
</tr>
<tr>
<td>360 1kg/800 Wash-down</td>
<td>6640ID 200kg/2.55m</td>
<td>**940</td>
</tr>
<tr>
<td>360 3kg/1130 Std No axis 4</td>
<td>6640 150kg/2.55m DP6</td>
<td></td>
</tr>
<tr>
<td>** requires the Stand Alone Controller mediapool that is available on the RobotStudio/RobotWare DVD.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Note

All simulation models in the table are installed with RobotStudio, but only the robots in the current product range are displayed in the ABB Library gallery. To import any other robot you need to browse to the file on disk.
Robot Libraries Paint

<table>
<thead>
<tr>
<th>Variant</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>52 short vertical arm</td>
<td></td>
</tr>
<tr>
<td>52 std vertical arm</td>
<td></td>
</tr>
<tr>
<td>540-12 std arm</td>
<td></td>
</tr>
<tr>
<td>580-12 std arm</td>
<td></td>
</tr>
<tr>
<td>580-12 short arm</td>
<td></td>
</tr>
<tr>
<td>5300-12 left</td>
<td></td>
</tr>
<tr>
<td>5300-12 right</td>
<td></td>
</tr>
<tr>
<td>5320-1500</td>
<td></td>
</tr>
<tr>
<td>5320-2000</td>
<td></td>
</tr>
<tr>
<td>5350/01 Type Left</td>
<td></td>
</tr>
<tr>
<td>5350/01 Type Right</td>
<td></td>
</tr>
<tr>
<td>5350/02 Type Left Side Left</td>
<td></td>
</tr>
<tr>
<td>5350/02 Type Left Side Right</td>
<td></td>
</tr>
<tr>
<td>5350/02 Type Right Side Left</td>
<td></td>
</tr>
<tr>
<td>5350/02 Type Right Side Right</td>
<td></td>
</tr>
<tr>
<td>5400-12 std arm</td>
<td></td>
</tr>
<tr>
<td>5400-13 std arm</td>
<td></td>
</tr>
<tr>
<td>5400-14 std arm</td>
<td></td>
</tr>
<tr>
<td>5400-22 process arm</td>
<td></td>
</tr>
<tr>
<td>5400-23 process arm</td>
<td></td>
</tr>
<tr>
<td>5400-24 process arm</td>
<td></td>
</tr>
<tr>
<td>5400-12 std arm axis 2 +60 deg</td>
<td></td>
</tr>
<tr>
<td>5400-13 std arm axis 2 +60 deg</td>
<td></td>
</tr>
<tr>
<td>5400-14 std arm axis 2 +60 deg</td>
<td></td>
</tr>
<tr>
<td>5500 35A b_00 / b_80</td>
<td></td>
</tr>
<tr>
<td>5500 35B b_00 / b_80</td>
<td></td>
</tr>
<tr>
<td>5500 ProArm 35A b_00 / b_80</td>
<td></td>
</tr>
<tr>
<td>5500 ProArm 35B b_00 / b_80</td>
<td></td>
</tr>
</tbody>
</table>

Track Libraries

RobotStudio is distributed with the following track types that are available in the Track folder of the ABB Library.

<table>
<thead>
<tr>
<th>Track family</th>
<th>Length</th>
</tr>
</thead>
<tbody>
<tr>
<td>IRBT4003</td>
<td>1.7 m to 10.7 m</td>
</tr>
<tr>
<td>IRBT4004</td>
<td>1.9 m to 19.9 m</td>
</tr>
<tr>
<td>IRBT6003</td>
<td>1.7 m to 10.7 m</td>
</tr>
<tr>
<td>IRBT6004</td>
<td>1.7 m to 19.7 m</td>
</tr>
<tr>
<td>IRBT7003</td>
<td>1.7 m to 10.7 m</td>
</tr>
<tr>
<td>IRBT7004</td>
<td>1.7 m to 19.7 m</td>
</tr>
<tr>
<td>RTT_Bobin</td>
<td>1.7 m to 11.7 m</td>
</tr>
<tr>
<td>RTT_Marathon</td>
<td>1.7 m to 11.7 m</td>
</tr>
<tr>
<td>Paint Rails</td>
<td>2 m to 20 m</td>
</tr>
<tr>
<td>left and right versions</td>
<td></td>
</tr>
<tr>
<td>IRB5350 Rail</td>
<td>3 m to 10 m</td>
</tr>
<tr>
<td>left and right versions</td>
<td></td>
</tr>
</tbody>
</table>
Positioner Libraries

RobotStudio 5.13.02 and later is distributed with the M2009 generation of positioners of type IRBP A, B, C, D, K, L and R and MTD. This represents the complete product range of the M2009 positioner series. The positioner libraries will be generated when the user selects the library from the menu ‘ABB Library’ gallery of the ‘Home’ tab of RobotStudio. The imported library will by default be part of the station. A consequence is that part positions can be modified. To prevent the library from being accidentally modified, it should be saved as a library. This can be done using the ‘Save As Library’ command.

The reason for not distributing the pre-compiled libraries is to reduce maintenance and footprint as the libraries are sharing many components. The function ‘System From Layout’ supports the new positioner generation and can be used to build a matching system.

**Note**

To use the IRBTX004 tracks the user must install the Track mediapool from the RobotStudio/RobotWare distribution.

**Note**

The M2001 library generation is available and can be imported using the **Browse for Library** command.
2 What’s new in RobotStudio 5.61

Overview
RobotStudio 5.61 is a quality release that only contains a few items that are described in this section.

Transparent materials (glass)
A set of transparent materials has been added to the materials gallery of the Graphics Tools functions (Edit tab).

Torch Service Center 2013
The library for Torch Service Center 2013 (TSC2013) is available in the Import Library gallery of RobotStudio.

ABB Force Sensors
The ABB range of force sensors is available in RobotStudio.
**Integrated Vision Calibration plates for print**

The calibration plates to use when calibrating the Integrated Vision camera are available as PDF documents in the RobotStudio installation folder. For a standard installation on Windows 7 64-bit, English version the path is

```
C:\Program Files (x86)\ABB Industrial IT\Robotics IT\RobotStudio 5.61\Bin\Addins\IntegratedVision
```

The subfolders that contain the grids are the following

- ..\Custom Grids
- ..\Cognex Grids
- ..\PDF Grids

**Integrated Vision 3D camera model**

A 3D model of the Integrated Vision camera is available in RobotStudio.

**Production Screen Widget Template**

A template for developing Production Screen widgets is available in ScreenMaker.

### 2.1 Other changes

**Gearbox Heat Prediction - warning level colors adjusted**

The warning levels colors for the gearbox heat prediction function has been adjusted. The new levels are

<table>
<thead>
<tr>
<th>Color</th>
<th>New level</th>
</tr>
</thead>
<tbody>
<tr>
<td>Green</td>
<td>0 – 80 %</td>
</tr>
<tr>
<td>Yellow</td>
<td>80 – 100%</td>
</tr>
<tr>
<td>Red</td>
<td>&gt; 100%</td>
</tr>
</tbody>
</table>
3 Late Breaking Information

Overview

This section contains information about late changes that were done after the RobotStudio 5.61 Operating Manual was finalized.

Summary

No late breaking information in RobotStudio 5.61
4 Corrections

Overview

This section describes the defects solved in RobotStudio.

4.1 Corrections in RobotStudio 5.61

Overview

This section describes the corrections made in 5.61

Product Defect Documents

<table>
<thead>
<tr>
<th>ID</th>
<th>Title</th>
</tr>
</thead>
<tbody>
<tr>
<td>1329</td>
<td>SafeMove Configurator - Buttons are disaligned</td>
</tr>
<tr>
<td>1958</td>
<td>Improvements of the Spanish language translation</td>
</tr>
<tr>
<td>2040</td>
<td>Integrated Vision – Localized text strings does not fit</td>
</tr>
<tr>
<td>2081</td>
<td>Integrated Vision – Unclear adjustment regions for camera calibration</td>
</tr>
<tr>
<td>2098</td>
<td>Round off problem for the JointMover SmartComponent</td>
</tr>
<tr>
<td>2153</td>
<td>Integrated Vision – Too little space for translated text strings</td>
</tr>
<tr>
<td>2157</td>
<td>Integrated Vision – UI Controls need more space for localized strings</td>
</tr>
<tr>
<td>2172</td>
<td>Integrated Vision – UI Control for Project name too narrow</td>
</tr>
<tr>
<td>2177</td>
<td>Integrated Vision - Vision job with null version</td>
</tr>
<tr>
<td>2189</td>
<td>Integrated Vision - Incorrect control size for localization</td>
</tr>
<tr>
<td>2370</td>
<td>AutoConfig with robot on track may throw exception</td>
</tr>
<tr>
<td>2574</td>
<td>Crash with 64 bit version if selecting Print</td>
</tr>
<tr>
<td>2578</td>
<td>Incorrect RobotWare version selected for GoOffline and System From Layout</td>
</tr>
<tr>
<td>2593</td>
<td>Leftovers after RobotStudio has been uninstalled</td>
</tr>
<tr>
<td>2620</td>
<td>System Builder buttons don’t always work and creates incomplete systems</td>
</tr>
<tr>
<td>2644</td>
<td>Pressing New View repeatedly will crash RobotStudio</td>
</tr>
<tr>
<td>2683</td>
<td>Improve error handling for VRML import</td>
</tr>
<tr>
<td>2688</td>
<td>Integrated Vision - Exception if camera powered off</td>
</tr>
<tr>
<td>2694</td>
<td>Integrated Vision - Blob tool coordinate system not showing up</td>
</tr>
<tr>
<td>2712</td>
<td>Integrated Vision - Add a command for camera disconnection</td>
</tr>
<tr>
<td>2718</td>
<td>ScreenMaker section of the Operating Manual needs to be updated</td>
</tr>
<tr>
<td>2755</td>
<td>No connection to VC after I-Start</td>
</tr>
<tr>
<td>2758</td>
<td>Add FlexPendant SDK as a pre-requisite for ScreenMaker in Operating Manual</td>
</tr>
<tr>
<td>2760</td>
<td>PowerPac Add In assemblies conflict</td>
</tr>
<tr>
<td>2781</td>
<td>Integrated Vision – Failure when connecting to camera</td>
</tr>
<tr>
<td>2837</td>
<td>Cannot select servo gun as external axis in System Configuration</td>
</tr>
<tr>
<td>2853</td>
<td>Network license overlap of activation keys</td>
</tr>
<tr>
<td>2951</td>
<td>Not possible to create station with paint system</td>
</tr>
<tr>
<td>2970</td>
<td>Download link for RW 5.15.0x required for GoOffline</td>
</tr>
<tr>
<td>2974</td>
<td>Screenmaker Requirements for .NET Compact Framework 3.5</td>
</tr>
<tr>
<td>2995</td>
<td>Target not created in the correct work object</td>
</tr>
<tr>
<td>2996</td>
<td>French Localization Improvement</td>
</tr>
<tr>
<td>2998</td>
<td>Integrated Vision – Incorrect control size for French localization</td>
</tr>
<tr>
<td>Issue Number</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>-------------</td>
</tr>
<tr>
<td>2999</td>
<td>Problem with View Robot at Target function and external axes</td>
</tr>
<tr>
<td>3019</td>
<td>Remove IRB7600 2.3 m 500 kg from ABB Library gallery</td>
</tr>
<tr>
<td>3038</td>
<td>Color removed from imported iges file</td>
</tr>
<tr>
<td>3039</td>
<td>Paths not shown in sync to station dialogue</td>
</tr>
<tr>
<td>3045</td>
<td>Restore of zipped Backup fails</td>
</tr>
<tr>
<td>3053</td>
<td>Locate target does not scroll in browser</td>
</tr>
<tr>
<td>3055</td>
<td>Loss of connection to service port, exception errors</td>
</tr>
<tr>
<td>3096</td>
<td>Geometry not showing</td>
</tr>
<tr>
<td>3100</td>
<td>Adding system to station with conveyor tracking</td>
</tr>
<tr>
<td>3116</td>
<td>Robot serial number is not written into SafeMove configuration file and safety report.</td>
</tr>
<tr>
<td>3122</td>
<td>Unpack&amp;work fails in certain circumstances</td>
</tr>
<tr>
<td>3128</td>
<td>Error in kinematic model of IRB6700-175/3.05</td>
</tr>
<tr>
<td>3134</td>
<td>MoveAbsJ problem with IRB 5500 with 2 Axes Swing Arm</td>
</tr>
<tr>
<td>3136</td>
<td>Characters not displayed in the graphic window</td>
</tr>
<tr>
<td>3154</td>
<td>Freehand rotational handles not always visible</td>
</tr>
<tr>
<td>3156</td>
<td>'Locate target' function not working as expected</td>
</tr>
<tr>
<td>3171</td>
<td>Invisible parts incorrectly detected by SmartComponent sensors</td>
</tr>
<tr>
<td>3189</td>
<td>Failure when modifying properties of Volume Sensor SmartComponent</td>
</tr>
<tr>
<td>3157</td>
<td>Examining a path with two coinciding targets corrupts station</td>
</tr>
<tr>
<td>3177</td>
<td>Incorrect RAPID module formatting</td>
</tr>
<tr>
<td>3234</td>
<td>PC Interface incorrectly required for RobotStudio addins when connected to service port</td>
</tr>
<tr>
<td>3246</td>
<td>RobotStudio crash</td>
</tr>
<tr>
<td>3272</td>
<td>TCP Trace fails with stationary sool</td>
</tr>
<tr>
<td>3315</td>
<td>Unpack&amp;Work fails to restore backup for certain controllers</td>
</tr>
</tbody>
</table>

### 4.2 Other limitations solved

#### Overview

This section describe other issues that are solved in 5.61.

#### RobotStudio 5.60 failed to generate working 64-bit Station Viewers

64-bit Station Viewers generated from RobotStudio 5.60 failed due to an incorrect component. This is corrected in RobotStudio 5.61.

#### Incorrect kinematics for the robot models of IRB 6700 with 3.05 m reach

The robot models for the IRB 6700 variants with 3.05 m reach were incorrect in 5.60. This is fixed in RobotStudio 5.61.

#### Migrate backup and CAD conversion required a PC reboot on Windows 8.1

It was required to reboot your PC after installation of RobotStudio 5.60 for the features Migrate Backup and CAD conversion to work as expected. The problem is solved in RobotStudio 5.61.

#### Warning about duplicate files appeared when multiple versions of same PowerPac was installed

When two or more versions of the same PowerPac was installed with RobotStudio 5.60, warning messages appeared in the Output window when RobotStudio was started. The
warning messages informed that duplicate files were installed. The problem is solved in RobotStudio 5.61

The state of an active clip plane was not saved

A clip plane that was activated before the station was saved did not become active when the station was re-opened in RobotStudio 5.60, but in 5.61 it does.

Not possible to save RAPID modules to UNC network paths

Saving a RAPID module to a UNC network path, i.e. a path beginning with '\\' did not work in RobotStudio 5.60. This is fixed in RobotStudio 5.61.

A problem with AutoSave made parts disappear.

The AutoSave function failed during certain circumstances in 5.60. The problem was the parts disappeared when the AutoSaved station was re-opened. The AutoSave function is corrected in RobotStudio 5.61.

The robot model for IRB 6620 LX was not imported correctly

When a virtual controller system for IRB 6620 LX was started, the corresponding robot model was not automatically imported into RobotStudio. In 5.61 the model will be correctly imported.

Window selection of 3D graphical objects failed

By using SHIFT + LEFT MOUSE BUTTON you can select objects using a window. The window selection method failed to correctly select all objects RobotStudio 5.60. RobotStudio 5.61 will correctly select all objects inside the selection window.

The Configuration Editor failed to open the Paint domain

When working with paint systems, there is a Paint domain available in the Configuration Editor. In RobotStudio 5.60 it was not possible to open that domain, but in 5.61 it is.
5 Known Limitations

Overview

This section describes known limitations in RobotStudio.

5.1 General

Only possible to open one SafeMove Configurator at the time

Only one SafeMove Configurator may be open at the time, even though several controllers may be connected. If the SafeMove Configurator is opened for one controller, real or virtual, the icon will become disabled for the other controller.

Compatibility of RobotStudio Library and Stations with older RobotStudio versions

RobotStudio is generally not forwards compatible, i.e. it is not possible to load stations or libraries created in RobotStudio 5.61 into an earlier version of RobotStudio such as e.g. RobotStudio 5.15.02, 5.60 or earlier. However, RobotStudio is backwards compatible, which means stations and libraries created in version 5.15.02, 5.60 or earlier can be opened in RobotStudio 5.61.

5.2 Online

*Individual RAPID tasks cannot be stopped for RobotWare 5.60 and later

When running multitasking systems, it is not possible to start and stop individual tasks with the dropdown menu of the task node in the Controller browser. This is due a restriction introduced with RobotWare 5.60 and later.

Signal Analyzer Online not available for RobotWare 5.60, RobotWare 5.15.02 and earlier

The feature Signal Analyzer Online is not available for controllers running RobotWare 5.60, RobotWare 5.15.02 and earlier. The reason is a vulnerability in Robotware that may cause interruptions in the robot operation.

Signal Analyzer Online is supported by Robotware 5.15.03 and later, and RobotWare 5.61 and later, where the problem has been corrected.

It is not recommended to use Signal Analyzer Online of RobotStudio 5.15.01 or 5.15.02 with RobotWare versions prior to 5.15.03 or 5.61.

SafeMove Tool Zone visualization in Online Monitor for robots with external axes

Only TCP robots and track mounted robots will be visualized in the Online Monitor, no other external axes or positioners.

As a consequence, the Online Monitor may show the robot in a non-violating position, even though the safety controller has detected a safety violation and stopped the robot.

FlexPendant Viewer running with automatic reloading

When having FlexPendant Viewer running with automatic reloading of the screens and at the same time jogging the robot with the joystick the robot jogging might halt when the FlexPendant Viewer reloads.

5.2.1 Online - Paint

Backup for Paint systems does not create backup of the PIB board

The Backup function of RobotStudio does not create a backup of the PIB board of the IRC5P system.
**Workaround**: Create the backup of the PIB board with the FlexPaint Pendant using an USB-stick.

**Go Offline does not work for Paint systems**

The Go offline function will not create a working Virtual controller system for Paint system unless the Paint package I/O option is set to Simulated.

**5.2.2 Online – Integrated Vision**

**Information – Integrated Vision only works on 32-bit installations**

It is not possible to use Integrated Vision in the 64-bit version of RobotStudio.

**Information – Camera firmware version and update**

The minimum firmware version to be used with Integrated Vision is 4.08. If this version is not available for a specific camera model, then the newest version available shall be used.

There are two important things to know before upgrading a sensor

- The user must make sure to first backup the files on the camera. This can be done using the Rapid snippets for camera backup/restore, or the FlexPendant Explorer.
- The latest available firmware version may vary across sensor types. However, when the firmware update utility presents the latest available version it shows the firmware with the highest version number which may not apply to the sensor to be updated. However, the appropriate firmware will be applied.

**Information – The spreadsheet view**

The spreadsheet view is not enabled when editing in the in the following modes “Add part location tool”, “Add part inspection tool”. Before entering the spreadsheet mode click for example “Setup Image” or Output to Rapid.

**Information – Calibration board without fiducial**

When using the calibration boards, checkerboard or board with dots, the user must select the preferred origin by clicking and accepting (press enter) three points on the board. Only after these three points have been selected is it possible to click “calibrate” to execute the calibration.

**Remaining error - Connect button greyed out for no reason**

It may sometimes happen that the “Connect” button is greyed out, with the tooltip saying the camera is not on the correct subnet although the IP settings are OK.

**Workaround**: Restart the Integrated Vision Add-In.

**Remaining error – VC started from Controller->Add controller does not detect cameras**

A VC that is started from Controller->Add controller does not detect cameras on the network, even if the VC_network_definition.xml is correctly configured and the firewall is turned off. The reason is that the controller is not able to detect new cameras on the network when it is in “Motors On” state. When the VC is started stand-alone in RobotStudio it is automatically set to “Motors On” when started.

**Workaround**: To allow it to discover cameras, turn the control panel key to manual mode or launch the VC as part of a station.

**User tip - Removing cameras from configuration**

To remove a configured camera from the list of configured cameras, use the configuration editor. Enter Configuration->Communication->Application Protocols and remove the desired camera. Perform a warm start to complete the operation.
User tip - Use default camera settings

If the camera is not using default communication settings the result may be that RAPID instructions return error code “Communication Error”. The safest method to get default settings is to go to Connect->Add Sensor Right click and select “Show all sensors”. Select the device to reset and click “Apply factory settings” in the lower right corner. The most important settings are:

Telnet port: 23
User: “admin”
Password: “”

User tip – Viewing all cameras present on the network

Connect->Add Sensor is normally used for setting the IP addresses of sensors that are not currently on the correct subnet (192.168.125.X). Since the dialog shows all cameras “seen” by the PC, this dialog is useful when error tracing camera network problems.

If a camera does not appear on the network using the “Add sensor” dialog as suggested above, it is advisable to cycle the power of the camera. If the camera receives power from the controller, then cycle power by turning the mains switch.

User tip – Warm start the controller after changing network settings

Whenever changing the network settings of the camera, either from Connect->Add Sensor or Connect->Network settings, it is important to warm start the controller. If this is not done, RAPID instructions will give the error “Communication Error” and the FTP-mounted camera disk is not accessible. If DHCP address is used and persists please try a static address instead.

5.3 Offline

5.3.1 General

Stations with IRB 6700 3.05m variant created in RobotStudio 5.60 becomes distorted

Due to a correction of 3.05 m variants of the IRB 6700, stations created in RobotStudio 5.60 will show a distorted robot model.

Workaround: Replace the robot library using “Path&Target->Controller->Edit System…->IRB6700_XX…-> Select from Library - > Change …-> ABB Library folder - >Robots folder – > Select the used robot model- > OK.”

The 2D work envelope fails for certain robot models

As a result, the generated work envelop may appear distorted.

Update of current selection in the 3D graphics window may be delayed

A problem related to the graphics driver has been observed on certain PCs. The problem is that the update of the current selection in the 3D graphics is delayed until the next redraw.

Workaround: Add or uncomment the following line in the file RobotStudio.exe.config

<add key="DoublePresentWorkaround" value="true" />

Failure to open Pack&Go file to same folder the second time

RobotStudio will prevent Pack&Go files to be opened to the same folder a second time if the station contains VC systems with the EPS or SafeMove option. This is by design to prevent the safety controller configuration file to be accidentally overwritten.

Workaround: Remove the write protection manually using Windows Explorer.
Updates of instruction template and code snippets

RobotStudio will not automatically update the user files for instruction templates and code snippets files in the folders:

...\My Documents\RobotStudio\Instruction Templates
...\My Documents\RobotStudio\Code snippets

Workaround: The user has to manually copy the latest files from

%ProgramFiles%\ABB Industrial IT\Robotics IT\RobotStudio 5.xx\Instruction Templates,
and

%ProgramFiles%\ABB Industrial IT\Robotics IT\RobotStudio 5.xx\Code Snippets
to the data folder.

IO signals configured with access level ‘DEFAULT’

When IO signals are configured with access level ‘DEFAULT’, only input signals are possible to set/reset from the I/O Simulator and I/O Window. To be able to affect also output signals, set the access level to ‘ALL’ for them in the Configuration Editor.

VC does not start with RRI option and GSI folder structure missing.

The VC will hang when started with a system containing the RobotWare option RRI (Robot Reference Interface) if the GSI folder structure is missing.

Workaround: create GSI Folder before starting the VC inside the HOME directory of the system. See the Application Manual for Robot Reference interface for more information.

System in Guard Stop state in Automatic mode after run-time error

Certain run-time errors may cause the controller system to enter Guard Stop state in Automatic mode. This is the same behavior as in a physical robot controller system. This typically happens when a run-time error related to Conveyor Tracking occurs. A simulation cannot be started when the controller is in this state.

Workaround: To reset the controller state, open the Control Panel window and first switch to Manual mode, and then back to Automatic mode.

Information message starting system with IRB260/460/660/760

Starting a system with IRB260/660 gives you an error message: ‘The number of joints is different between the library model and the controller configurations’. The reason is that the IRBx60 is modeled with six joints in RobotStudio of which two are locked, but has four joints in the VC.

Path handling of instructions with multiple joint targets

The path functions Rotate, Translate, and Mirror do not work as expected with instructions containing via points as joint targets. The functions will leave the joint targets as is. Interpolate Path gives an Unknown Error and Tool Compensation reports an error message.

Event Manager: Simulation cannot be triggered by analog system signals

The event manager only supports analog station signals, not analog system signals.
5.3.2 Station Viewer

The command **Record to Viewer** is only enabled in **Time Slice** mode

The command **Record to Viewer** requires the **Virtual Time** mode of the RobotStudio Options to be set to **Time Slice**. Otherwise, i.e. if the Virtual Time mode is set to **Free Run**, the button will be disabled.

**Workaround:** Enable Record to Viewer by setting the Virtual Time mode to **Time Slice**.

Memory problem when doing **Save As Viewer** or **Record to Viewer** with large stations

RobotStudio may run out of memory (**OutOfMemory exception**) when doing **Save As Viewer** or **Record To Viewer** if the station is very large.

**Workaround:** Use the 64-bit version of RobotStudio and create a 64-bit viewer by ticking the checkbox in the **Save As Viewer** file dialog.

5.3.3 Signal Analyzer

**Maximum 26 signals can be exported**

The number of signals that can be exported to Excel is limited to 26.

5.3.4 MultiMove

**Definitions for Workobject and tooldata must be specified in each task**

Workobjects and tooldata that are shared (i.e. declared as PERS) between several tasks must be specified in RAPID with its full value for each task when programming offline with RobotStudio. This will give rise to the warning ‘Initial value for PERS not updated’ in the controller event log. The warning can be ignored in this case. However, you must carefully ensure that the RAPID variable definitions are the same in all tasks, otherwise you may get unexpected behavior.

**Include MultiMove option for system with several TCP robots**

When creating a system for several manipulators (up to four) with SystemBuilder, either of the RobotWare options **MultiMove Independent**, or **MultiMove Coordinated** must be included for all of the related motion tasks to start.

**Note**

It is recommended to use the function **System From Layout** if applicable when creating robot systems for RobotStudio. Then the MultiMove option will automatically be added whenever required.

**MultiMove error: ‘Object reference not set to an instance of an object’**

When the Test Play button is pressed in the MultiMove tool, the following error message may be displayed: ’Object reference not set to an instance of an object’, but the robot moves and the Status ’Calculation OK’ is displayed. In addition, when ‘Create Paths’ is pressed the following message is displayed: ’Can't create paths : Value cannot be null’, and no paths are created. In the ‘Create Paths Settings’, is the WP TCP drop down empty.

**Reason:** wobj is not set for the current task
5.3.5 Virtual FlexPendant

**The FlexPendant Option ‘Non Motion Execution’ is not supported**

The FlexPendant has the option ‘Non-motion Execution’ that can be set to prevent the real controller from moving even though the program is executing. RobotStudio will ignore this option and move the robot anyhow.

**Controller switched to Automatic mode when RAPID instruction UiShow is executed**

RobotStudio will automatically request mastership to the controller to update a data value, whenever the RAPID instruction ‘UiShow’ instruction is used. This will only happen if the Virtual Operator Window is enabled. When starting Virtual Flexpendant with enabled Virtual Operator Window, a message window is launched, explaining that unexpected behaviour may occur.

**Workaround:** Disable the Virtual Operator Window in RobotStudio options.

**Automatic mastership when interaction required in Virtual Operator Window**

RobotStudio will automatically request mastership when committing data to the controller, when actions are taken in Virtual Operator Window. This can cause undesired effect when using the Virtual FlexPendant at the same time.

**Workaround:** Disable the Virtual Operator Window in RobotStudio options.

**Virtual Flex Pendent: Emergency Stop button**

When the emergency stop button is pressed on the Virtual FlexPendant, it cannot be reset through the VC Control Panel. The button must be reset on the Virtual FlexPendant.

5.3.6 External Axis

**Error 50091: ‘Restart not possible’ after warm start of a system with external axis**

When restarting a system with activated mechanical units the activation state is lost. Then the program can no longer be started from the Virtual FlexPendant, the RAPID Editor or the RAPID Tasks window.

**Workaround:** Reset the program pointer (‘Program Pointer to Main’) before starting the program from the Virtual FlexPendant, the RAPID Editor or the RAPID Tasks window, or, start the program from the Simulation Play button.

**JointTargets for external axis**

JointTargets for external axis are not visualized in the graphical window.

5.3.7 Network Drives and UNC Paths

**RobotStudio on computers with roaming user profiles**

RobotStudio may fail on PC configurations with roaming user profiles, i.e. when the users’ documents folder resides on a server and not on the local disk.

**Workaround:** Redefine the ‘User Project Folder’ to a folder on the local disk (File → Options → General → Files&Folders → User Project Folder).

**Virtual Controller does not support UNC paths**

UNC paths cannot be used to locate Virtual Controller systems. Using UNC paths for VC systems will cause the log message ‘Failed to initialize FW upgrade framework’ to appear when the system starts. Subsequent attempts to work with the VC such as synchronizing RAPID data will fail.
Creating and starting systems located on a network drive

When using a network drive to store RobotStudio data such as RobotWare systems or the RobotWare mediapool, the following problems may occur

- Virtual controller does not start
- Not possible to open VirtualFlexpendant

**Cause:** By default, the .NET Framework does not allow execution of code from a remote file system. This means the application may behave unexpectedly if the media used by the system or the system itself resides on a network share.

**Workaround:** To resolve this, the user must explicitly grant the required permissions:

1. Open the file `Virtual FlexPendant.exe.config` located in
   `C:\Program Files (x86)\ABB Industrial IT\Robotics IT\RobotStudio 5.61\Bin`
2. Add the following lines

```xml
<?xml version="1.0"?>
<configuration>
  <startup useLegacyV2RuntimeActivationPolicy="true">
    <supportedRuntime version="v4.0" sku=".NETFramework,Version=v4.0"></startup>
  <runtime>
    <loadFromRemoteSources enabled="true"/>
    <!-- THIS IS ONE OF THE NEW LINES!!! -->
  </runtime>
  <!-- THIS IS ONE OF THE NEW LINES!!! -->
</configuration>
```

The Virtual FlexPendant must be restarted for the changes to take effect.

For further information, see


---

**Note**

Windows security settings may prevent the file from being directly edited in the default location. Copy the file to your local Documents folder to edit it. Upon completion, you need to manually copy the file back to its original location.

5.3.8 RAPID

*Robtargets that are local to a procedure are not supported by Synchronization to Station*

Robtargets that are local to a procedure are not supported by Synchronize to Station. Only robtargets that are local to a module are supported (PDD 3139).

*Global robtargets cannot be made local through Synchronization to VC*

Global robtargets cannot be changed to local through Synchronize to VC, the option is disabled (PDD 3140).

**Workaround:** Change the robtargets to module local in the RAPID Editor and Synchronize to station.

**RAPID Profiler limitations**

- The Spy function does not produce useful output for systems based on RobotWare option CAP (Continuous Application Platform). This is the case for e.g. systems with the RobotWare options Arc and RW Cutting. This affects the RAPID Profiler that analyses the log generated by the Spy function.

- The RAPID Spy function, which produces the input to the RAPID Profiler, measures **RAPID program execution time** as opposed to motion execution time. In many cases,
however, it is the motion execution time that is of interest. To make these two times coincide for the RAPID procedures, ensure that the last move instruction of all procedures is a so-called stop point, e.g programmed with speedata fine. Otherwise, the RAPID instruction execution time will be lower than the motion execution time. The reason is that the program execution runs ahead of the motion execution unless the programmed point is a stop point. Read more about stop points in the RAPID Reference Manual included with RobotStudio. In particular, see zonedata and stoppointdata.

Breakpoints deactivated when running simulation.

When running a simulation (Simulation Play) in time slice mode, all breakpoint set in the RAPID editor window(s) will be deactivated temporarily. This will prevent a situation, which may cause RobotStudio to hang, when a hitting a breakpoint during simulation.

Error Message: Sync. to Station completed with errors

Error Message: Sync to Station completed with errors: New data <name> <type> has same name as existing object in same block <routine>.

When this error message appears, there is a storage type mixup between data already stored in RS and in the VC. Because of this, and per design, the data is not considered the same data.

Workaround: 1. Ensure all data declarations have the same definition in RS as in RAPID (there is no user interface for this).
2. Sync to station should now work.
3. Sync back to controller, and remember to change the data declarations back to what you want.

Array of robtargets, tooldata and workobjects are not supported

RAPID programs containing arrays of tooldata, robtargets and workobjects are not supported, i.e. they will not be synchronized to the station.

The RAPID functions Offs and RelTool are not fully supported

RobotStudio does not fully support instructions using Offs or RelTool functions. They will be synchronized and will appear in the element browser, but commands such as “View Tool at Target” and “Locate Target” will not work. Targets used in the instructions will not be visible in the graphics. However, instructions can programmed and edited using the RAPID Editor and successfully simulated using the VC.

5.3.9 Building Controller systems

Virtual Controller systems must be l-started after Modify System

A virtual controller system that has been modified using the function Modify System of the System Builder must be l-started for the changes to take effect.

Modify system with additional Mediapool(s) not in default location.

Trying to modify a system, which references one or several additional options mediapools not placed in the same folder as the used RobotWare mediapool, will cause the System Builder to fail to modify the system. Workaround: Copy the additional options mediapool to the default mediapool location (i.e. %ProgramFiles%\ABB Industrial IT\Robotics IT\Mediapool)

Not possible to Modify System for Pack and Go file.

It is not possible to use the function Modify System of the System Builder for a system that uses a mediapool embedded in a Pack&Work file.
**Workaround**: Copy the mediapool to the common Mediapool folder, and create the system from the backup

---

**System From Layout requires custom made track motion to be saved as library**

The System From Layout requires that any custom made track motions used to be saved as library

---

**Move/Copy of Virtual Controller systems**

Warm-started systems cannot be moved to another location and/or PC. This will result in a non-working VC.

A typical symptom of the problem is that the Virtual Controller reports *Failed to retrieve procedure*.

**Workaround and recommended method of working:**

1. Use ‘Pack & Go’ to pack the station and system backups in a zip file.
2. Use ‘Unpack & Work’ to unpack the zip file created by ‘Pack & Go’.

---

**5.3.10 Paint**

**Lack of Virtual Controller support for the Paint systems**

Paint systems that are configured using the Paint package I/O option Discrete, Compact or Fieldbus, will result in a SysFail state.

**Workaround**: Re-create the system with the simulated I/O option.

**No Virtual FlexPaint Pendant available**

There is no Virtual FlexPaint Pendant available for Virtual Controller systems with paint robots.

**Workaround**: Use the regular Virtual FlexPendant instead.

**Hidden main entry point for Paint systems**

Controller systems for Paint robots (IRB5XXX) has a hidden main procedure to handle the so-called job-queue. This is why the user must define a new entry point, e.g. main2, using the Setup Simulation tool to avoid conflicts when working with a paint robot in RobotStudio.

**Only single robot setups supported for Paint systems**

It is possible to create the system with System builder for both single & multi paint robot systems using Virtual Key & Paint option. But a System failure will occur starting the Multi paint robot system. Only Single paint robot system can be started.

---

**5.3.11 Conveyor Tracking**

**Circular Conveyor Tracking not supported**

RobotStudio does not support tracking of circular conveyors. Only linear conveyors are supported.

**Compiling a Conveyor Mechanism does not disable the Compile button**

After compiling a conveyor mechanism, using the Create Mechanism tool, the Compile Mechanism button is not disabled. If the user presses the Compile button again, without changing anything, another identical conveyor mechanism will be created.
Conveyor Tracking programs must be started with the Simulation-Play button

It is not possible to successfully run a RAPID program with Conveyor Tracking from the Virtual FlexPendant or from the RAPID Editor. The reason is that RobotStudio must simulate the Conveyor Encoder Unit in order to provide the required I/O signals to the system. This is only possible when running a simulation.

**Workaround:** Start the simulation with the Simulation-Play button of RobotStudio instead of the Virtual FlexPendant or the RAPID Editor.

The same part can only be attached once on a Conveyor

It is not possible to attach the same part on a conveyor more than once.

**Workaround:** Import the same part several times, or copy and paste the part in the Layout browser, before attaching them to the conveyor.

---

**Note**

The part must not be attached to the conveyor during the copy and paste operations, then the copy will get the wrong transform.

---

### 5.3.12 Graphics and Geometry

*Conversion of ProE/Creo files fails for RobotStudio 64-bit edition on Windows 8 / 8.1*

ProE and Creo files of type .prt and .asm cannot be converted in the 64-bit edition of RobotStudio or the 64-bit edition of the standalone CAD Converter.

**Workaround:** Convert the file to SAT using the 32-bit CAD Converter or RobotStudio and load the SAT file into the 64-bit edition of RobotStudio.

---

**Load station without geometry**

Opening a station with the option ‘Load Geometry’ unchecked, followed by saving the station, will cause the geometry (underlying CAD data) to be permanently removed.

**Workaround:** None.

---

**The Healing option may increase size of CAD models**

The healing option may be used during CAD import to try and heal CAD-models. For some CAD-models the size is increased a factor of ten.

**Workaround:** Uncheck the Healing option in the Import Geometry dialog or the CAD-converter.

---

**Problems when undoing Boolean operations on Geometry**

Undoing a Boolean operation might not succeed. To recover from these problems, you need to delete the items that caused the problem.

---

**Out of memory**

The application might fail when out of memory due to the import of very large ACIS files or load of very large stations.

**Workaround:** Use the 64-bit version that can handle more memory. Ensure that you have enough memory installed on the PC, see System Requirements.
5.3.13 Gearbox Heat Prediction Tool

Only support for one robot in each VC

When a virtual controller has more than one robot, only one robot will have predictions calculated. The other robots will only display 0% chance of overheating.

5.4 ScreenMaker Limitations

Undo Redo support

Undo and Redo operations in ScreenMaker is not supported.

Dynamic update of Rapid Data

The switch from Manual Mode to Auto Mode causes the RAPID boolean data bound to the enabled property of control change to value TRUE. This behaviour is noticed when the mode is changed from a different screen and not on the screen where the control is bound to RAPID boolean data. An additional side effect is that the enabled property of RunRoutine button has been disabled as similar behavior was seen.

Not possible to add sub menu items on Command Bars

The FlexPendant controls have the ability to have sub menu items when a command bar button is pressed. This is not supported.

Not possible to add signals to ListBox / ComboBox

When adding items to the ListBox/ComboBox control, it is not possible to add I/O signals.

Group box controls with Numpad

NumEditor control is placed as a sibling of the GroupBox. Numpad control gets opened on clicking the NumEditor. If NumPad does not fit inside the parent of NumEditor, in this case the GroupBox, the controls that were disabled by NumPad are not enabled again.

The workaround is to make sure that the numpad fits inside the parent of the NumEditor.

You must also avoid scenarios where the NumEditor is put outside a GroupBox (or any other control) where the Enabled property of any child control is bound to controller data.

If all controls of a ScreenMaker screen are siblings it should be fine when using the NumEditor while binding Enabled properties of controls.
Unicode characters not supported

When creating a new SM project you are not allowed to use chars like "åäö".

Adding ScreenMaker.sys file

The following error occurs if ScreenMaker.sys entry is not available in SYS.CFG file of robot system.

![Error Message]

To overcome this copy the following entry shown below

- File "RELEASE:/options/gtpusdk/ScreenMaker.sys" -ModName "ScreenMaker"
- AllTask -Hidden

And paste it under CAB_TASKS_MODULES in the file SYS.CFG

Save and Load the modified SYS.CFG file back into the robot system. Warmstart the robot system.

Running Routine with Movement

RunRoutine Button control does not always work correct when a routine with movements is called.

As a workaround use instructions like StopMove, StorePath, RestorePath and StartMove to control the movements of the robot.

A Trap routine could be called with a normal button control and in the Trap the above instructions can be used to control the movements of the robot.

PictureBox control as a Widget

If a Picture Box control is created as a widget from a Windows 8 operating system, the control is not shown on the FlexPendant. The behavior is fine with any other operating system like Windows 7.
6 RobotWare Compatibility

6.1 General

**Supported RobotWare versions**

RobotStudio 5.15 is distributed with RobotWare 5.15 and works with RobotWare 5.05 and later. Please see below for details.

**6.2 RobotWare 5.05 and 5.06 Compatibility**

RobotWare 5.05 and 5.06 including revisions thereof are not supported by RobotStudio 5.15 and later versions. Please use the corresponding version of RobotStudio for managing robot controllers with any of these RobotWare versions.

**6.3 RobotWare 5.07 Compatibility**

RobotWare 5.07 and its revisions of are supported with the following limitations:

**General**

The location of the program pointer is not updated in the RAPID Editor during program execution.

**Offline**

A limitation in the versions 5.07.02, 5.07.03, and 5.07.04 of RobotWare may cause the Virtual Controller to System Failure state during I-start on certain computers. The problem is due to the ctrl.bin-file not being correctly created.

*Workaround:* Create an empty ctrl.bin file in the INTERNAL folder of the controller system, and then perform a warm start.

**Note**

The problem will reappear if the system is I-started.

The virtual controller does not support RobotWare 5.07.08 and RobotWare 5.07.07.

**Online**

*FlexPendant Viewer* does not work RobotWare 5.07

**6.4 RobotWare 5.08 Compatibility**

RobotWare 5.08 and its revisions of are supported with the following limitations:

**Offline**

RobotWare 5.08 is not supported.

*Workaround:* Use RobotWare 5.08.01 or later.

**6.5 RobotWare 5.10 Compatibility**

RobotWare 5.10 and its revisions of are supported with the following limitations:

**Offline**

Starting a controller will generate internal UAS error in controller error log.
6.6 RobotWare 5.11 Compatibility
RobotWare 5.11 and its revisions of are supported with the following limitations:

**Offline**
Linear jogging of a robot across joint values that will cause a change of confdata may fail. For example, if the robot is jogged linearly when joint values is passing 90 degrees for axis 1 may cause the robot to stop or to change configuration.

6.7 RobotWare 5.12 Compatibility
RobotWare 5.12 and its revisions of are supported with the following limitations:

**Paint backups from RW 5.12.01 not compatible with RW 5.12.02 or later**
Restoring a paint system backup from RobotWare 5.12.01 will cause SysFail for RobotWare 5.12.02 or later

**Workaround:** Add the following parameters to the configuration files

**EIO.CFG:**

```plaintext
EIO_SIGNAL:
  -Name "doMainInMC" -SignalType "DO" -Unit "SysComm" -UnitMap "44"
  -Name "AIHVErrNo" -SignalType "DO" -Unit "SysComm" -UnitMap "150-151"
    -Access "ALL"
  -Name "AIHVEn" -SignalType "DO" -Unit "SysComm" -UnitMap "155"
    -Access "ALL"
EIO_CROSS:
  -Res "AIHVEn" -Act1 "HVEnabled"
```

**SYS.CFG:**

```plaintext
CAB_TASK_MODULES:
  -File "INTERNAL:/pntrapid/T_ROB1/cycinfo.sys" -ModName "cycinfo"
  -Task "T_ROB1"
  -File "INTERNAL:/pntrapid/csvlkup.sys" -ModName "csvlkup" -AllTask
    -Hidden
```

6.8 RobotWare 5.13 Compatibility
RobotWare 5.13 and its revisions of are supported with the following limitations:

**Paint backups from RW 5.12.02, 5.12.03 or RW 5.13 or 5.13.01 not compatible with RW 5.13.02 or RW 5.13.03**
There are several changes in the configuration database for I/O (EIO.CFG) and Controller (SYS.CFG) that will cause System Failure if an old backup is loaded. There are also changed in installed RAPID modules. To create a compatible configuration, proceed as follows:

1. Create and start a VC with a RobotWare 5.13.03 system containing the same options as your original backup, but do not load the backup.
2. Save the EIO.CFG and SYS.CFG to file.
3. Compare the saved files with the corresponding files of your backup. (You can use a text file comparison tool for simplification.)
4. Add your system-specific configuration to the general configuration files saved from the 5.13.01-system using a text editor.
5. Replace the files of the original backup with the corresponding modified configuration files.
6. Go through the RAPID modules of the backup and remove the default modules (i.e. those that are not changed by the user).
7. Load the backup and restart the system. You are done.

6.9 RobotWare 5.15 Compatibility

**Signal Analyzer Online**

The feature Signal Analyzer Online requires RobotWare 5.15.03 or later.

6.10 General Compatibility Limitations

**RAPID Profiler**

The profiler will be able to create a log file for the profiler automatically for RobotWare 5.14 or later. For RobotWare 5.13 or earlier, the log file must be created manually using the RAPID Spy command (SpyStart/SpyStop).

**Safety Configuration**

Safety configuration of a track motion IRC5 system equipped with a safety controller of type EPS or SafeMove can be done without the need to read track motion parameters manually when using RobotWare 5.11.01 or later. Encrypted parameters needed by the safety controller will be automatically read by EPS Wizard and SafeMove Configurator, respectively.

**Signal Analyzer Online**

Signal Analyzer Online requires RobotWare 5.15.01 or later.

**Signal Analyzer.**

The error message *Failed to subscribe on signal* may sometimes appear during signal recording for RobotWare 5.15 or earlier.

*Workaround:* Restart the VC or upgrade to RobotWare 5.15.01 or later.

**Configurations**

The feature Configurations for selecting the robot arm configuration (*confdata*) may fail, or not present all solutions, in some specific circumstances even when the target is reachable if RobotWare 5.14 or earlier is used.

*Workaround:* Upgrade to RW5.14.01 or later

**Virtual FlexPendant**

For RobotWare 5.15 and earlier the Virtual FlexPendant may become blank. Another symptom of this problem is that the controller browser is not expandable.

The problem is due to in incomplete startup of the virtual controller.

*Workaround:* I-start the virtual controller or use RobotWare 5.15.01 or later

6.11 ScreenMaker Compatibility

**RobotWare**

It is possible to use previous RobotWare versions, but with some limitations.

- ActionTrigger will work only on RobotWare 5.12.02 or later.
- The controls Button, TipsLabel and PictureBox controls was modified in RobotStudio 5.13. The property 'Allow MultipleStates' of these controls can be accessed from RobotWare 5.13 and later.
- Variant Button will work only on RobotWare 5.14.01 or later
- Conditional Trigger will work only on RobotWare 5.14.01 or later
- Widgets will work only on RobotWare 5.60 or later.

**FlexPendant SDK**

ScreenMaker should be used with FlexPendant SDK 5.12.02 or later. ScreenMaker allows selection of FlexPendant SDK version when it is launched. If only one version of FlexPendant SDK is available in the system, it is loaded by default.

**6.12 Support for future RobotWare versions**

RobotStudio 5.61 supports all future minor revisions of RobotWare 5.61, but no future major releases. For example, RobotStudio 5.61 will support RobotWare 5.61.01 (if, and when available) but not RobotWare 5.62, or 6.x..
7 Installation information

7.1 Installing RobotStudio

**Installation Instructions**

RobotStudio 5.61 will be installed side-by-side with any previous installation of RobotStudio. It uses the same activation key.

RobotStudio requires RobotWare to be installed. Optionally, the Track mediapool may also be installed to add support for the track motions IRBTx004.

**How to install RobotStudio on a PC**

<table>
<thead>
<tr>
<th>Action</th>
</tr>
</thead>
</table>
| 1  | Insert the robot software DVD in the PC.  
|    | • If a menu for the DVD is opened automatically, continue with step 5.  
|    | • If no menu for the DVD is opened, continue with step 2. |
| 2  | On the **Start** menu, click **Run**. |
| 3  | In the **Open** box, type the drive letter for your DVD drive followed by:  
|    | :\launch.exe  
|    | If your DVD drive has the letter D, then type: D:\launch.exe |
| 4  | Click **OK**. |
| 5  | Select the language for the DVD menu. |
| 6  | On the DVD menu, click **Install**. |
| 7  | On the installation menu, click **RobotStudio**. This opens the installation wizard, which guides you through the rest of the software installation. |
| 8  | After installing **RobotStudio**, you can proceed with installing **RobotWare**.  
|    | Go to the installation menu, and click **RobotWare**. This opens this installation wizard, which guides you through the rest of the RobotWare installation. |
| 9  | This step is optional, and is for installing the Track mediapool.  
|    | On the **Install products** menu, click **Additional Options**. This opens a file browser that displays the Track mediapool installation and other available options.  
|    | Double-click the **TrackMotion** folder and then the file setup.exe to start the installation wizard and proceed |

**Note**

For an immediate trial period of 30 days, RobotStudio will work without activation.

**Knowing which RobotStudio version is installed**

The version number of your RobotStudio installation is displayed on the RobotStudio title bar.

**Activation of RobotStudio license**

Activation of your RobotStudio installation is a procedure for validating your RobotStudio license. To continue using this with all of its features, you must activate it. RobotStudio Product Activation is based on Microsoft anti-piracy technology and is designed to verify that software products are legitimately licensed. Activation works by verifying that the Activation Key is not in use on more personal computers than are permitted by the software license.

When you start RobotStudio for the first time after installation, you are prompted to enter your 25-digit Activation Key (xxxxx-xxxxx-xxxxx-xxxxx-xxxxx). The software performs in the Basic Functionality mode if you do not use a valid Activation Key.
After the installation is activated, you will have valid licenses for the features covered by your subscription.

**Note**
Activation is not required for Minimal installation, or for Basic Functionality mode of the Complete or Custom installation.

---

**What is Basic Functionality mode**

In Basic Functionality mode, which is a reduced functionality mode, RobotStudio allows only the use of the basic features for the real and the virtual controller. No existing files or stations are harmed in this mode. After activating your software, you will have full functionality for the features you have purchased.

A real controller can be programmed, configured and monitored over Ethernet without activating your installation of RobotStudio. Activation, however, will provide access to the Premium productivity features that will make your engineering work more efficient.

---

**How to activate RobotStudio**

Use the Activation Wizard to activate your RobotStudio installation. When you start RobotStudio for the first time after installation, the wizard starts automatically and prompts you for the Activation Key. If you do not want to activate your copy of RobotStudio at installation, you can do so later using the Activation Wizard.

**Note**
If you have a problem with your activation, contact your local ABB customer support representative at the e-mail address or telephone number provided at [http://www.abb.com/contacts](http://www.abb.com/contacts).

For using the Activation Wizard, follow this procedure.

<table>
<thead>
<tr>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
</tr>
<tr>
<td>2</td>
</tr>
</tbody>
</table>

In the Activation Wizard, on the **Activate RobotStudio** page, indicate whether you have a **Standalone License** or a **Network License**, and then click **Next**.

- If you have chosen **Standalone License**, you will proceed to the **Activate a Standalone License page**. See **Activate automatically over the Internet or manually** below for further steps.
- If you have chosen **Network License**, you will proceed to the Network License page. See the **RobotStudio Operating manual** for further steps.

---

**Activate automatically over the Internet or manually**

The Activation Wizard gives you two choices on how to proceed. You can choose either automatic activation over the Internet or manual activation. These are explained in the following section.

**Automatic Activation (recommended)**

In Automatic Activation, the Activation Wizard automatically contacts and sends your activation request to the ABB licensing servers over your Internet connection. Your license will then be automatically installed and your product will be ready for use.
For Automatic Activation you need a working Internet connections and also a valid Activation Key that has not exceeded the number of installations allowed.

RobotStudio must be restarted after the activation has been successfully completed.

**Note**

If you choose to activate over the Internet but are not currently connected to the Internet, then the wizard alerts you that there is no connection.

---

**Manual Activation**

1. If the computer does not have a working Internet connection, you must proceed with Manual Activation:

2. Create a license file by selecting the option **Step 1: Create a license request file**. Proceed through the wizard, enter your Activation Key and save the License Request File to your computer.

3. Use a removable storage medium, such as a USB stick or floppy disk, to transfer the file to a computer with an Internet connection. In that computer, open a web browser, go to [http://www101.abb.com/manualactivation/](http://www101.abb.com/manualactivation/) and follow the instructions given.

   The result will be a License File that should be saved and transferred back to the computer having the installation awaiting activation.

4. Relaunch the Activation Wizard and go through the steps until you reach the **Activate a Standalone License page**.

5. Under **Manual Activation**, select the option **Step 3: Install a license file**.

   Proceed through the wizard, selecting the License File when requested. Upon completion, RobotStudio is activated and ready for use.

   RobotStudio must be restarted after the activation has been successfully completed.

---

**How can I tell whether my RobotStudio installation has already been activated?**

1. Go to the **File** tab, and then click on the **Options** button, and select the **Licensing** section.

2. Click **View Installed License Keys** to see the status of your current license.

3. If your RobotStudio installation is activated, you will have valid licenses for the features covered by your subscription.

---

**Network licenses**

Network licenses are available for schools and ABB certified partners.
8 Technical support

8.1 Overview

Contacting ABB

If you have any questions or problems with your RobotStudio installation, please get in touch with your local ABB Robotics Service representative, see http://www.abb.com/contacts.

Have the following in mind

1. Running the latest version of RobotStudio helps ensure that it works properly and includes improvements and new product functionality. ABB recommends that you update to the latest version of RobotStudio whenever a new version is available and before contacting ABB for support.

2. Give a brief description of how to reproduce your problem.

3. Create screenshots if applicable. (Use ALT + PRINT SCREEN to get an image of the active window instead of the entire screen.)

4. Generate a Full Scan with the RobotStudio Support Tool available next to RobotStudio in the Start menu, save the report and attach it with your problem description. (Click Start → Programs → ABB Industrial IT → Robotics IT → RobotStudio → RobotStudio Support Tool, click on Run Full Scan and then Save Report.

5. We also need the following user information:
   i. name
   ii. company
   iii. contact information
   iv. what operating system you are running (incl. language)
   v. subscription ID for your purchased license.
   vi. Machine ID, see Help section of File tab.

Note

When sending large (> 1 Mb) files, please compress them with WinZip® or WinRAR.

License support

For license-related questions, please contact the team responsible for license support directly at softwarefactory_support@se.abb.com